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Prefácio 

Existem muitos livros que discutem as habilidades do hardware Arduino e como o fabricante pode usá-lo melhor em seu benefício. Tenho muitos deles na minha estante e versões digitais no meu celular e tablet – caso eu fique entediado com a vida e precise de algo interessante para ler. Muitos desses livros explicam o que o hardware faz; e alguns até se aprofundam no hardware para explicar como, em termos bastante fáceis de entender, isso acontece. 

Não existem livros que tenham uma visão semelhante do software Arduino. Existe agora! Este livro leva você em uma jornada (por que sempre temos que viajar hoje em dia?) pelo mundo dos esboços do Arduino e pelos vários arquivos envolvidos no processo de compilação. Ele se aprofundará no software fornecido e examinará as partes específicas da linguagem Arduino que lidam com o hardware subjacente, os microcontroladores ATmega328P (ou ATmega328AU) – doravante denominados 

ATmega328P. 

Uma vez explicada a linguagem do Arduino, o livro dá uma breve olhada em como você pode remover a mão do Arduino e se sujar com o hardware nu. Não é fácil, mas igualmente não é muito difícil. Não se preocupe, esta ainda é a linguagem C/C++, não é necessária nenhuma linguagem assembly. Talvez! 






1. Introdução 

(1) 

Rawdon, West Yorkshire, Reino Unido 



O Arduino é um ótimo sistema para levar as pessoas a criar eletrônicos e microcontroladores. Fui reintroduzido em um hobby há muito perdido quando ganhei um Arduino Duemilanove (também conhecido como 2009) da falecida avó de minha esposa e, desde então, tenho me divertido muito aprendendo e tentando construir coisas. Eu até construí vários clones do Arduino baseados apenas no microcontrolador AVR e em alguns componentes passivos – é mais barato do que instalar um novo Arduino em um projeto! 

Muita coisa mudou ao longo dos anos seguintes. Os LEDs custavam cerca de £ 10 cada e vinham em uma cor, vermelho. Hoje em dia posso conseguir um pacote de 100 LEDs por cerca de £ 2 em várias cores diferentes. Melhor ainda, meu velho e fiel ferro de solda Antex 15W ainda funcionava, mesmo depois de 35 anos. 

O Arduino, e estou me concentrando no Uno versão 3 ou no Duemilanove aqui, já que esses são dois dos que comprei (ou recebi), é baseado em um microcontrolador Atmel 

ATmega328. No Uno é o Atmel ATmega328P-AU, enquanto o Duemilanove usa o ATmega328P-PU. 

Aproximadamente, a única diferença entre os dois é que a versão AU do UNO é uma montagem em superfície, enquanto a versão PU é um dispositivo passante de 28 

pinos. Eles são/devem ser idênticos ao programa, embora a versão AU possua dois pinos analógicos adicionais que não estão presentes no ATmega328P-PU. 

Ocasionalmente, porém, posso mencionar de passagem o Mega 2560 R3 – já que tenho um clone chinês barato de um deles – que é baseado no microcontrolador Atmel ATmega2560. 

Algumas placas Arduino mais antigas tinham o microcontrolador ATmega168, que também era uma versão passante de 28 pinos, mas tinha apenas 16 Kb de memória flash em oposição aos 32 Kb dos 328 chips posteriores. O tamanho da EEPROM e da RAM também é metade do tamanho dos dispositivos ATmega328P. 

O Arduino foi projetado para ser fácil de usar e, para isso, o software e a “linguagem Arduino” escondem muita coisa do fabricante e do desenvolvedor. Esperançosamente, quando você terminar de ler este livro, você entenderá mais sobre o que ele faz e por que e, quando necessário, como você pode ignorar a linguagem Arduino (afinal, é apenas C ou C++) e usar o bare metal AVR- código C ou C++ específico. Fazer isso pode resultar em mais espaço para seu código, execução mais rápida e menores requisitos de energia – alguns projetos podem ser executados por meses com algumas baterias. 

1.1 Caminhos de instalação do Arduino 

A versão do software Arduino usada neste livro é 1.8.5. 

Usei uma instalação no Windows 7 e outra no Linux enquanto escrevia este livro, embora o Linux seja meu sistema operacional preferido. Ambas as versões foram instaladas baixando a versão do arquivo zip, em vez do instalador apropriado, e extraindo-o. Os locais que usei são os seguintes: 

• 

No Linux – /home/norman/arduino-1.8.5 

• 

No Windows 7 – c:\usuários\norman\arduino-1.8.5 

Neste livro, há referências a vários arquivos fornecidos pelo software Arduino. Devido à maneira como instalei meu software e ao fato de que as versões do instalador do download podem ser instaladas em um local diferente, todos os caminhos usados neste livro serão relativos aos locais anteriores. 

Os caminhos utilizados serão os seguintes: 

• 

$ARDBASE é o local anterior onde extraí o arquivo zip – 

/home/norman/arduino-1.8.5. É aqui que você encontrará o arquivo 

arduino.exe no Windows ou arduino no Linux que é o IDE do Arduino. 

• 

$ARDINST é o local dos principais arquivos Arduino para microcontroladores AVR. Este é $ARDBASE/hardware/arduino/avr e é onde os vários núcleos, 

bootloaders e assim por diante podem ser encontrados, abaixo deste diretório. 

No meu sistema Linux, este é o caminho /home/norman/arduino-

1.8.5/hardware/arduino/avr. 

• 

$ARDINC é o local de muitos dos arquivos de cabeçalho *.h e da maioria dos arquivos *.c e *.cpp que compõem a linguagem Arduino para 

microcontroladores AVR. Isso é $ARDINST/cores/arduino. O caminho 

expandido é /home/norman/arduino-

1.8.5/hardware/arduino/avr/cores/arduino no meu sistema Linux. 

• 

$AVRINC é onde estão localizados os arquivos de cabeçalho da versão da 

biblioteca AVR fornecida pelo Arduino IDE. A linguagem Arduino 

(eventualmente) é compilada para chamar funções dentro da biblioteca AVR 

(doravante denominada AVRLib), e os arquivos de cabeçalho podem ser 

encontrados no local $ARDBASE/hardware/tools/avr/avr/include. O caminho totalmente expandido aqui é /home/norman/arduino1.8.5/hardware/tools/avr/avr/include. 

Então, se você vir $ARDINC/Arduino.h mencionado, você saberá que isso significa que o arquivo 

• 

/home/norman/arduino-

1.8.5/hardware/arduino/avr/cores/arduino/Arduino.h no Linux 

• 

c:\users\norman\arduino-

1.8.5\hardware\arduino\avr\cores\arduino\Arduino.h no Windows 

Você pode ver por que estou usando abreviações agora, não é? 

Além disso, a maioria dos caminhos de arquivo aos quais me refiro estarão no formato Linux com “/” como separador de caminho, a menos que eu esteja me referindo especificamente a um arquivo do Windows, caso em que o caminho do arquivo usará o 

“\” Windows. caractere separador de caminho. 

Se você deseja examinar os arquivos que estou discutindo no livro em seu sistema, consulte o Apêndice A para obter algumas dicas úteis sobre como evitar sempre ter que digitar os caminhos completos. 


1.2 Estilo de Codificação 

As listagens de códigos no livro serão exibidas da seguinte forma: 

#define ledPin LED_BUILTIN 

#define reléPino 2 

#define sensorPin 3 







... 

loop vazio() ① 

{ 

// Pisca o LED de pulsação. 

digitalWrite(ledPin, ALTO); 

atraso(100); 

digitalWrite(ledPin BAIXO); ② 

... 

} 

• 

① Este é um texto explicativo e tenta chamar sua atenção para algo no código que será descrito abaixo da listagem de código em questão. 

• 

② Este é outro texto explicativo – pode haver mais de um. 

No texto principal do livro, onde você vê palavras formatadas como USCR0A ou PORTB, então estes são exemplos de nomes de pinos do Arduino, registros de microcontroladores AVR, bits dentro desses registros e/ou sinalizadores dentro do próprio ATmega328P, bem como referências a algo listado na folha de dados do dispositivo. Onde as listagens de código estão sendo explicadas, as variáveis do código também serão mostradas neste estilo. 

Os números dos pinos do Arduino serão nomeados Dn ou An conforme apropriado. 

Isso é um pouco diferente do uso normal dos pinos digitais, que normalmente recebem apenas um número. Prefiro ser um pouco mais formal e dar o título completo aos pins digitais. <sorriso> 

As dicas são exatamente isso. Eles fornecem uma pista ou informação sobre algo que pode não ser muito conhecido no mundo Arduino, mas que pode ser 

incrivelmente útil (ou, talvez, apenas um pouco útil!). 

Esta é uma nota. Chama sua atenção para algo que pode exigir um pouco mais de informação. Pode ser útil prestar atenção a estas notas. Talvez! 

Os cuidados existem para destacar possíveis problemas com algo no 

software ou apenas algo que a folha de dados precisa que você tome cuidado extra. 

Pode haver possibilidade de danos ao seu Arduino se você não prestar atenção 

especial. Ocasionalmente, a ficha técnica alerta contra fazer algo – então é melhor não fazer o que diz para não fazer! 


1.3 A Linguagem Arduino 

Talvez eu deva salientar que não existe realmente a linguagem Arduino. Posso me referir a isso com frequência nas páginas deste livro, mas tecnicamente ele não existe. 

O que é simplesmente uma abstração da linguagem C/C++, escrita de forma a facilitar a vida das pessoas que estão aprendendo a fazer coisas com seu Arduino. Qual das alternativas a seguir é mais fácil de entender? 

digitalWrite(13, ALTO); 

ou 

PORTB |= (1 << PORTB5); 

A primeira é definitivamente mais fácil de entender; entretanto, o último é de longe o mais rápido dos dois, pois apenas faz o que diz – define o pino 5, no PORTB do ATmega328P, para HIGH. O nome, digitalWrite(), parece ser uma linguagem diferente, mas não é; é essa abstração do AVR C/C++ simples que torna a vida mais fácil para todos nós. 


1.4 chegando 

No capítulo2,  explico como um esboço é transformado em um programa C++ 

adequado e como as bibliotecas usadas no esboço são incorporadas a ele. Seguindo a breve visão geral de como funciona a compilação de um esboço, documento a função main() do Arduino, os vários arquivos de cabeçalho que ela inclui e a inicialização realizada pela função init(). Essas inicializações fazem parte de cada esboço que você compila, então será útil saber o que o sistema Arduino está fazendo em segundo plano para você. 

No capítulo3,  explico sobre os recursos e facilidades da linguagem Arduino. Isso incluirá todos os comandos como pinMode(), digitalWrite() e assim por diante. Falo sobre todas as funções relacionadas ao Arduino, com especial ênfase no código que se aplica às placas Arduino padrão, aquelas baseadas na família ATmega328P de microcontroladores AVR. 

Capítulo4analisa uma série de classes (ou objetos) C++ que são fornecidas e usadas pela linguagem Arduino. As classes de principal interesse aqui são a classe HardwareSerial que nos fornece a interface serial e seus comandos como 

Serial.begin() ou Serial.println(). Entretanto, a classe HardwareSerial não é totalmente independente; portanto, as outras classes de suporte, menos conhecidas, também são explicadas neste capítulo. 

Capítulo5dá uma breve olhada em como se livrar dos laços da linguagem Arduino e mergulha no mundo descarado do próprio AVR C++, onde você ignora chamadas como pinMode() e conversa com o microcontrolador AVR em algo semelhante à sua própria 

linguagem. Aqui você aprenderá como definir pinMode() para até oito pinos com uma única instrução ou como digitalWrite() esses mesmos oito pinos, novamente com uma instrução, e outros métodos eficientes de comunicação com sua placa. 

Capítulo6demonstra algumas alternativas para o Arduino IDE. Algumas pessoas não se dão bem com isso. Eu mesmo tenho uma espécie de relação de amor e ódio com isso, pois acho o editor um pouco desajeitado e lento para o meu gosto. 

Neste capítulo, mostrarei como você pode escrever código para placas Arduino tanto na linguagem Arduino quanto em código AVR C/C++ simples usando o sistema 

“PlatformIO” e, também, dar uma prévia do próximo “Arduino Command- Interface de linha (CLI). 

A interface de linha de comando do Arduino será a base para uma versão futura do IDE do Arduino, mas você também pode usá-la em arquivos make, no ambiente de linha de comando e assim por diante. Não requer a instalação do Java como o IDE 

atual. 

Capítulo7é onde me aprofundo em alguns recursos do ATmega328P que, embora não sejam estritamente software, são fundamentais para configurar o ATmega328P como você gostaria e não como os projetistas do Arduino, por mais talentosos que sejam, decidiram. Neste capítulo, examinarei os fusíveis, modos de redução de energia, modos de suspensão e recursos semelhantes do ATmega que determinam como o ATmega328P funciona, mas não necessariamente o que ele faz. 

Capítulos8e9é onde me aprofundo em alguns recursos do ATmega328P que, embora não sejam estritamente software, são importantes para a compreensão da linguagem Arduino ou apenas úteis para conhecer. Recursos de hardware como comparador analógico, temporizadores/contadores, conversor analógico para digital (ADC) e receptor/transmissor síncrono/assíncrono universal (USART) são abordados com alguns detalhes. 

Por fim, nos apêndices, há uma série de tópicos que podem ser de interesse ou que estão reunidos em um só lugar para referência. Aqui você encontrará todo o material de referência útil de que pode precisar, como diagramas de pinagem e código potencialmente útil (ou incomum) para carregar em seu Arduino. 

Existe até um índice! 

Sem mais delongas, vamos ver o que acontece quando você deseja compilar um esboço no IDE do Arduino. 



N. DunbarInternos do software Arduinohttps://doi.org/10.1007/978-1-4842-5790-
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2. Compilação Arduino 

Norman Dunbar1 

(1) 

Rawdon, West Yorkshire, Reino Unido 





Este capítulo é sobre o que acontece quando você compila um esboço do Arduino e como os vários arquivos de cabeçalho são usados. Esperançosamente, quando você tiver lido (e entendido) este capítulo do livro, você terá uma ideia muito melhor do que acontece durante a compilação de um esboço do Arduino. No entanto, antes de mergulharmos nos detalhes sangrentos da compilação de um esboço, precisamos entender um pouco sobre alguns dos arquivos de texto que residem dentro e ao redor do diretório $ARDINST. 

Esses arquivos são utilizados para configurar as opções do menu do IDE e definir o microcontrolador AVR e a placa Arduino a serem utilizados. Além disso, o IDE precisa saber como compilar e fazer upload de esboços, e com muitas placas diferentes hoje em dia, não apenas aquelas com microcontroladores AVR, esses numerosos arquivos de texto ajudam o IDE a configurar as ferramentas de construção e assim por diante, para a placa específica escolhida. o menu Placas no IDE. 

Depois de discutirmos os vários arquivos de texto, podemos então começar a trabalhar no processo de compilação e também dar uma olhada nos arquivos C++ 

ocultos que o ambiente Arduino mantém bem longe de nós. 


2.1 Preferências.txt 

O arquivo preferências.txt contém todas as preferências do IDE do Arduino e nas versões recentes do IDE não é mais encontrado no local dos vários arquivos IDE, mas em uma área separada para que atualizações futuras do IDE não substituam quaisquer alterações que você faz no arquivo. Isso explica por que, quando você configura o IDE 

em uma versão, uma atualização selecionará suas preferências sem que você precise reaplicá-las sempre que atualizar. 

Você deve encontrar o arquivo em um dos locais a seguir, pois o arquivo é criado quando você executa o IDE pela primeira vez. Se você ainda não tiver feito isso, não haverá um arquivo preferências.txt para ser encontrado. O conjunto inicial de padrões é definido no arquivo $ARDINST/lib/preferences.txt, portanto esses serão gravados no arquivo preferências.txt, no local apropriado, na primeira execução do IDE. Você também pode excluir o arquivo preferências.txt se suas edições o tornarem inutilizável, e ele será recriado pelo IDE na próxima vez que você abri-lo. 



Você poderia editar $ARDINST/lib/preferences.txt para definir suas próprias configurações padrão preferidas, mas como o arquivo será substituído pelas atualizações do IDE, provavelmente não é uma boa opção a ser considerada. 

A única coisa sobre procurar em $ARDINST/lib/preferences.txt é o fato de que tudo é bem comentado para aconselhá-lo sobre para que servem as opções. O arquivo que o IDE realmente usa não é comentado. Se você precisar saber o que está prestes a alterar, consulte o arquivo $ARDINST/lib/preferences.txt, mas altere aquele que está no local correto para o seu sistema. O arquivo usado pelo IDE é encontrado em vários lugares, dependendo do sistema operacional de sua escolha: 

• 

No Linux – procure em /home/<SEU_NOME>/.arduino15. 

• 

No Windows 7 – Procure em 

C:\Users\<SEU_NOME>\AppData\Local\Arduino15. Acredito que em versões mais antigas do Windows, o arquivo pode ser encontrado em c:\Documents 

and Settings\<SEU_NOME>\Application Data\Arduino ou mesmo C:\Program Files (x86)\Arduino\lib que acredito ser onde 32 aplicativos de bits são instalados em máquinas de 64 bits. 

• 

No MacOS – acredito que você pode procurar em 

/Users/<YOUR_NAME>/Library/Arduino, mas não tenho acesso a um Mac para verificar, desculpe. 

A maneira mais fácil de determinar a localização do arquivo preferências.txt é abrir o IDE e selecionar Arquivo ➤ Preferências; e na aba “Configurações”, na parte inferior, você verá o caminho completo para o arquivo preferences.txt documentado. Preste atenção ao aviso para editar o arquivo somente quando o IDE estiver fechado – o IDE 

grava no arquivo quando você o fecha e substituirá quaisquer alterações feitas se o IDE estiver aberto quando você alterou o arquivo. 

O arquivo preferências.txt contém todas as alterações de configuração feitas usando o IDE. As alterações feitas aqui serão salvas entre atualizações do IDE. Existem algumas alterações adicionais nas preferências que você precisa fazer editando o arquivo de preferências diretamente, pois o IDE não “apresenta” essas opções. Seguem alguns exemplos. 

Se você tiver suas preferências bem configuradas, tome cuidado ao instalar e usar posteriormente o novo utilitário de linha de comando do Arduino arduino-cli (consulte o Capítulo6,  Seção 6.2, “Linha de comando do Arduino” para obter detalhes). 

Ele usa o mesmo local para todos os seus arquivos e seleciona todas as preferências que você configurou para o IDE. 





Se, por acaso, você cometer um erro ao editar o arquivo e as coisas pararem de funcionar (corretamente), você pode redefinir tudo para os padrões simplesmente excluindo o arquivo preferências.txt enquanto o IDE está fechado e executando o IDE 

novamente. 

2.1.1 Usando um ICSP para todos os uploads 

Você está usando um ICSP (In-Circuit System Programmer) para fazer todos os seus uploads? Você fica cansado de ter que configurá-lo em cada esboço que escreve e tenta enviar? Não seria legal dizer ao IDE que você está sempre usando um ICSP? 

Experimente isto: 

• 

Feche o IDE se estiver aberto. 

• 

Edite o arquivo preferências.txt em seu editor de texto favorito. (Não, não use o Microsoft Word!) 

• 

Procure por “upload.usando”. Atualmente deve estar assim: 



upload.using=bootloader 

• 

Altere-o para usar o nome do dispositivo que você está usando. O nome do dispositivo para o qual você o altera deve corresponder a um dos nomes de dispositivo no arquivo $ARDINST/programmers.txt. No meu caso, eu uso um clone USB Tiny, do eBay, e defino minha opção como o seguinte: 



upload.using=USBtinyISP 

• 

Salve o arquivo. 

Feito isso, todos os esboços agora usarão o ICSP em vez do bootloader. Isso significa que não preciso mais me preocupar em lembrar de trocar o programador no IDE e, como bônus, sempre irei sobrescrever a área do bootloader e recuperar o uso daquela parte da Flash RAM para meu próprio uso. Minha placa Uno terá 512 bytes extras (1,5625% do total) de flash para meus programas, enquanto meu Duemilanove recuperará 2 Kb extras ou 6,35% do espaço do bootloader. 

O upload com qualquer dispositivo ICSP ainda exige que você pressione a tecla Shift ao clicar no botão de upload ou selecione Sketch ➤ Upload Using Programmer, mesmo com esta preferência definida. 

Ainda posso configurar o IDE para usar um bootloader. Só preciso lembrar de selecioná-lo no menu Ferramentas quando desejo criar um esboço para um sistema que não posso ou não quero usar o ICSP para uploads. 





O que é um ICSP? Normalmente os iniciantes usariam um cabo USB entre o 

computador e o Arduino para fazer upload de programas. No entanto, olhe para o seu Arduino e veja se você consegue ver um conjunto de seis pinos em duas fileiras de três. Meu Duemilanove os tem abaixo do botão de reinicialização. Esses pinos são onde um ICSP pode ser conectado para programar o Arduino. Usar um deles libera o espaço ocupado pelo programa bootloader e oferece um pouco mais de espaço de programa. 

Infelizmente, isso impede que o Arduino responda ao seu computador usando o recurso Serial Monitor – Tools ➤ Serial Monitor. Você precisará de um ICSP se precisar substituir o ATmega328P em sua placa, e ele vem com as configurações de fusível padrão. Você precisará comprar um com um bootloader Uno já programado ou usar um ICSP para programar o seu próprio. 

Meu ICSP é de um vendedor do eBay “finetech007” que não existe mais. Existem muitos deles se você pesquisar “usbtiny isp” – aqui está um exemplo 

[www.ebay.co.uk/itm/USBTiny-USBtinyISP-AVR-ISP-programmer-for-Arduino-

bootloader-Meag2560-uno-r3-

CF/191780957944?epid=1138358692&hash=item2ca7092ef8:g:4-UAAOSwhvpd-

fY7],  idêntico ao meu. (Desculpe pelo comprimento desse URL!) 2.1.2 Alterar a ação das teclas Home e End 

Estou informado de que isso se aplica a usuários do Apple Mac. Certamente não tem efeito no Windows 7 ou Linux. 

No editor, quando você pressiona a tecla Home, o cursor salta para o início do esboço. 

Quando você pressiona a tecla End, ela salta para o final do esboço. Aparentemente, isso fica muito chato quando você espera que o cursor seja posicionado no início ou no final da linha que você está editando. Esse tipo de coisa definitivamente precisa mudar! 

Não há uma opção em Arquivo ➤ Preferências que permita que esta ação seja alterada para que o cursor vá para o início ou fim da linha atual e não para o início ou fim do esboço atual. O arquivo preferências.txt deve ser editado diretamente: 

• 

Feche o IDE, se estiver aberto. 

• 

Edite o arquivo preferências.txt. 

• 

Procure a seguinte configuração: 



editor.keys.home_and_end_beginning_end_of_doc = verdadeiro 

• 

Altere para o seguinte e salve o arquivo: 





editor.keys.home_and_end_beginning_end_of_doc = falso 

Na próxima vez que você abrir o IDE e carregar um esboço, as teclas Home e End agora deverão atender às suas ordens. 

O problema 3715 na página de problemas do GitHub para o IDE traz alguns detalhes interessantes sobre essa preferência. Só existe a partir da versão 1.6.6. Antes disso, chamava-se editor.keys.home_and_end_travel_far. 

Nas primeiras encarnações da versão 1.6.6, a configuração foi codificada de trás para frente. Definir como falso significava que as teclas Home e End enviavam o cursor para o início ou fim do documento. Você teve que defini-lo como verdadeiro para ir para o início ou fim da linha atual. 

Desde 28 de agosto de 2015 isso foi corrigido; e agora funciona como deveria. Você pode encontrar todos os detalhes 

emhttps://github.com/arduino/Arduino/issues/3715.  


2.1.3 Configurando paradas de tabulação 

Agora, você pensaria que um editor, para escrever código, permitiria pelo menos a capacidade de ajustar a largura das paradas de tabulação e se elas devem ou não ser convertidas em espaços. Não é assim com o Arduino IDE! 

Nem tudo está perdido, pois temos essa capacidade, mas envolve editar o arquivo preferências.txt novamente: 

• 

Feche o IDE se ele estiver aberto no momento. 

• 

Edite o arquivo preferências.txt. 

• 

Procure as duas linhas a seguir: 



editor.tabs.expand=true 



editor.tabs.size=2 

• 

Altere a segunda linha conforme a seguir: 



editor.tabs.expand=true 



editor.tabs.size=4 

• 

Salve o arquivo. 

Isso faz com que as tabulações recuem quatro caracteres do padrão de dois caracteres. 

Não sei sobre você, mas acho os recuos de dois caracteres bastante ilegíveis quando observo a estrutura de um esboço. Eu uso quatro para quase tudo que faço. A primeira linha anterior, que não foi alterada, determina se o IDE converterá caracteres de tabulação em espaços. Quando definido como verdadeiro, o IDE converterá tabulações 

em espaços, enquanto falso deixará os caracteres de tabulação como estão, inalterados. 

Isso torna a edição no IDE um pouco mais confortável, na minha opinião. 


2.2 Caminhos Definidos Globalmente 

Antes da leitura dos vários arquivos de texto, o IDE do Arduino define algumas propriedades definindo vários caminhos e outras para si mesmo. Essas propriedades são globais e podem ser usadas em qualquer outro arquivo de configuração, inclusive o seu. Essas propriedades definidas globalmente estão listadas na Tabela2-1.  

Tabela 2-1 

Propriedades definidas globalmente 

Nome da propriedade 

Descrição 

{tempo de 

O caminho absoluto do diretório de hardware que é a 

execução.hardware.path}  pasta que contém o arquivo platform.txt atual. 

{runtime.ide.path} 

O caminho absoluto do diretório onde o aplicativo 

arduino (ou arduino.exe), o Arduino IDE, se encontra. 

{runtime.ide.versão} 

O número da versão do Arduino IDE como um número 

válido. Cada componente do número da versão será 

convertido para usar dois dígitos. Em seguida, todos os 

pontos são removidos e, finalmente, quaisquer zeros à 

esquerda são removidos, deixando o valor final. Por 

exemplo, o Arduino IDE versão 1.8.5 se tornará 

“01.08.05”, que se tornará “010805” antes de 

finalmente ser atribuído como 

runtime.ide.version=10805. As versões do IDE 

anteriores à versão 1.6.0 usavam um único dígito para 

o número da versão do IDE. Por exemplo, a versão 1.5.6 

era 156 em oposição a 10506. 

{ide_versão} 

Alias de compatibilidade para runtime.ide.version. 

{tempo de execução.os} 

O sistema operacional no qual o IDE está sendo 

executado atualmente. Os valores são “linux”, 

“windows” e “macosx”. 

Essas configurações globais podem ser usadas em platform.txt, boards.txt ou, talvez, mas não muito provavelmente, programmers.txt. Você também pode usar esses caminhos em suas alterações nos arquivos de configuração ou nas diversas versões 

“locais” que você criar. 



Vários arquivos de configuração podem ter uma versão local; boards.txt, por exemplo, pode ter boards.local.txt. Esta versão local permite que você faça alterações na configuração do sistema e não precise reconfigurar toda vez que o IDE do Arduino for atualizado. Infelizmente, nem todos os arquivos de configuração têm uma versão local – programmers.txt é um que encontrei e que não tem. 

Verhttps://github.com/arduino/Arduino/issues/8556para obter detalhes, se você estiver interessado. 


2.3 Quadros.txt 

O arquivo $ARDINST/boards.txt define as várias opções de menu para diferentes tipos de dispositivos microcontroladores. Essas opções aparecerão no menu Placas no IDE 

do Arduino ou serão usadas quando uma placa específica for selecionada nesse menu. 

O arquivo é lido e as diversas opções são decodificadas e usadas pelo IDE na inicialização. Novas placas podem ser adicionadas de forma bastante simples, se desejado, editando este arquivo. Vejamos a entrada do Arduino Uno. 


2.3.1 Exemplo do Arduino Uno 

A seguir está a listagem completa de todas as entradas para o Arduino Uno, na versão 1.8.5 do IDE – outras versões, tanto mais antigas quanto potencialmente mais recentes, podem ser diferentes: 

uno.name=Arduino/Genuíno Uno ① 

uno.vid.0=0x2341 ② 

uno.pid.0=0x0043 

uno.vid.1=0x2341 

uno.pid.1=0x0001 

uno.vid.2=0x2A03 

uno.pid.2=0x0043 

uno.vid.3=0x2341 

uno.pid.3=0x0243 

uno.upload.tool=avrdude ③ 

uno.upload.protocol=arduino 

uno.upload.maximum_size=32256 

uno.upload.maximum_data_size=2048 

uno.upload.speed=115200 

uno.bootloader.tool=avrdude ④ 

uno.bootloader.low_fuses=0xFF 

uno.bootloader.high_fuses=0xDE 

uno.bootloader.extended_fuses=0xFD 

uno.bootloader.unlock_bits=0x3F 

uno.bootloader.lock_bits=0x0F 

uno.bootloader.file=optiboot/optiboot_atmega328.hex 

uno.build.mcu=atmega328p ⑤ 

uno.build.f_cpu=16000000L 

uno.build.board=AVR_UNO 

uno.build.core=arduino 

uno.build.variant=padrão 

• 

① Nome do conselho. 

• 

② Esta seção define as configurações de identificação usadas para determinar a identidade da placa quando ela é conectada à porta USB do seu computador. 

• 

③ Essas configurações definem os parâmetros usados para enviar o código compilado para a placa. 

• 

④ As configurações do bootloader estão listadas nesta seção. 

• 

⑤ Várias opções de construção são especificadas aqui. 

O Arduino Wiki emhttps://github.com/arduino/Arduino/wiki/Arduino-IDE-1.5-3rd-

party-Hardware-specificationmenciona, pelo menos para a versão 1.5.3 do IDE, que parece ser a documentada mais recentemente, que 

 Este arquivo contém definições e metadados das placas suportadas. Cada placa deve ser referida através de seu nome abreviado, o ID da placa. As configurações de uma placa são definidas através de um conjunto de propriedades com chaves tendo como prefixo o ID da placa.  

O que não menciona é como o sistema deve saber que “uno”, por exemplo, se refere ao dispositivo Arduino/Genuino Uno. 

Pela listagem anterior, é bastante óbvio que o nome abreviado do Uno deve ser “uno”, pois esse é o prefixo usado para cada entrada nesta seção do arquivo. 



 2.3.1.1 Identificador da Placa 

O parâmetro name aqui identifica a placa e define o que será exibido no menu Placas do IDE: 

uno.name=Arduino/Genuíno Uno 

 2.3.1.2 Configurações de identificação 

As configurações desta seção ajudam a identificar um Arduino Uno genuíno. Quando você conecta um dispositivo a uma porta USB, o dispositivo é consultado para obter um fornecedor e um identificador de produto. Isso ajuda o sistema a carregar os drivers corretos (principalmente Windows) ou, na primeira vez, solicita que você carregue os drivers apropriados para o dispositivo. Para o Uno, os seguintes quatro pares de fornecedores e identificadores de produtos são conhecidos como genuínos: uno.vid.0=0x2341 

uno.pid.0=0x0043 

uno.vid.1=0x2341 

uno.pid.1=0x0001 

uno.vid.2=0x2A03 

uno.pid.2=0x0043 

uno.vid.3=0x2341 

uno.pid.3=0x0243 

Nas configurações: 

• 

Vid é o identificador do fornecedor. 

• 

Pid é o identificador do produto do fornecedor específico. 

No texto anterior, podemos ver claramente dois fornecedores – “0x2431” e “0x2A03” 

– e os identificadores de produto apropriados para cada fornecedor. Tenha em mente que não é necessariamente o fabricante real da placa Arduino que está sendo identificado; é mais provável que seja o chip que converte os dados da porta USB no formato correto para o microcontrolador. Algumas placas Uno possuem outro microcontrolador AVR cuidando das comunicações, enquanto outras possuem um chip FTDI – ambos serão registrados como pids diferentes. 

Placas genuínas, como a minha Duemilanove, que usa um chip FTDI para 

comunicações, não serão necessariamente reconhecidas como a placa correta. Isso se deve ao chip FTDI, que usa pid e vid genéricos e é usado por inúmeras placas diferentes. No entanto, isso não é motivo de preocupação. 



 2.3.1.3 Configurações de upload 

Quando você clica no botão de upload no IDE, as configurações definidas nesta seção do arquivo boards.txt são usadas para definir vários parâmetros conforme desejado, para permitir a comunicação adequada com a placa atualmente escolhida: 

uno.upload.tool=avrdude 

uno.upload.protocol=arduino 

uno.upload.maximum_size=32256 

uno.upload.maximum_data_size=2048 

uno.upload.speed=115200 

Para especificar a ferramenta a ser utilizada para realizar o upload, utiliza-se o parâmetro upload.tool. Neste exemplo, a ferramenta em uso é o programa 

denominado avrdude. Esta ferramenta é instalada ao mesmo tempo que o Arduino IDE. 

O protocolo de comunicação a ser usado durante o upload é definido no parâmetro upload.protocol, enquanto os tamanhos máximos de Flash e RAM estática (SRAM) para o microcontrolador AVR específico em uso são definidos nos parâmetros upload.maximum_size e upload.maximum_data_size, respectivamente. 

O tamanho máximo da Flash RAM de um ATmega328P é 32.768 bytes, então 

por que upload.maximum_size permite apenas 32.256 bytes? Isso ocorre porque os 512 bytes restantes são usados para o bootloader. O bootloader Optiboot tem 512 

bytes de tamanho, portanto essa quantidade de Flash RAM precisa ser reservada do máximo disponível. 

Na verdade, o bootloader Optiboot tem apenas 500 bytes de tamanho. Você pode ver isso ao observar os endereços inicial e final no arquivo de listagem de compilação, $ARDINST/bootloaders/opitiboot/optiboot_atmega328.lst, que são 7E00hex e 7FF3hex, respectivamente. Subtrair dá 1F3hex que é 499decimal, mas precisamos adicionar um porque começamos a contar do zero. 

As comunicações serão realizadas na taxa de transmissão especificada em upload.speed. Para este exemplo do Uno, isso será de 115.200 baud. 

 2.3.1.4 Configurações do carregador de inicialização 

Esta seção do arquivo boards.txt define vários parâmetros a serem usados quando você escolhe Gravar bootloader no menu IDE. 

Deveria ser óbvio (não deveria?) Que gravar um bootloader exigirá um dispositivo In-Circuit System Programmer (ISCP), pois o microcontrolador AVR no qual você está 



gravando um bootloader ainda não possui um bootloader para permitir o upload via normal Conexão USB à placa! 

Você deve ter muito cuidado para garantir que selecionou a placa correta ao gravar um bootloader – em um dia bom, ela simplesmente não funcionará. Em um dia ruim, ele irá acionar os fusíveis para algo que pode lhe causar algum sofrimento ao tentar desvendar e ser reprogramado. Em um dia realmente ruim, ele pode converter sua premiada placa Arduino em algo parecido com um tijolo. 

Ok, provavelmente não é tão ruim assim, mas você pode acabar precisando comprar um novo ATmega328P e, com sorte, será um que venha completo com um bootloader Uno gravado. exercitar tudo de novo. 

Sim, eu admito. Eu fiz brick em uma placa Arduino, então é assim que eu sei. Era uma placa Digispark com um microcontrolador ATtiny85, mas eu a bloqueei mesmo assim! 

A investigação mostrou que configurei o fusível para desabilitar o pino RESET para que ele pudesse ser usado como um pino de E/S normal. Nenhuma programação com um programador de alta tensão iria resgatá-lo, então deve ter havido algumas outras configurações que eu quebrei também. 

Ainda tenho o dispositivo em algum lugar e um dia descobrirei o que fiz de errado e, com sorte, consertarei. Talvez. 

Continuando a observar as configurações padrão de um Arduino Uno, podemos ver as seguintes configurações: 

uno.bootloader.tool=avrdude 

uno.bootloader.low_fuses=0xFF 

uno.bootloader.high_fuses=0xDE 

uno.bootloader.extended_fuses=0xFD 

uno.bootloader.unlock_bits=0x3F 

uno.bootloader.lock_bits=0x0F 

uno.bootloader.file=optiboot/optiboot_atmega328.hex 

Para especificar a ferramenta a ser utilizada para realizar o upload, é definido o parâmetro bootloader.tool. No caso do Uno que estamos analisando aqui, a ferramenta utilizada é o programa chamado avrdude – o mesmo do texto anterior para upload de esboços compilados. 

Conforme descrito no Capítulo7,  Seção 7.1, “Fusíveis ATmega328P”, o microcontrolador AVR possui vários fusíveis que podem ser utilizados para definir várias configurações do próprio microcontrolador AVR. Os parâmetros 

bootloader.low_fuses, bootloader.high_fuses e bootloader.extended_fuses definem as configurações de hardware necessárias para o microcontrolador na placa. 

Finalmente nesta seção, o parâmetro bootloader.file define qual dos muitos bootloaders fornecidos com o IDE deve ser usado para esta placa. O Uno usa o arquivo optiboot/optiboot_atmega328.hex que pode ser encontrado no diretório 

$ARDINST/bootloader/. 

Você pode, se desejar, alterar o bootloader editando o arquivo boards.txt para alterar o parâmetro apropriado ou duplicando uma seção existente e alterando o bootloader. 

A última opção é preferida. Vale a pena ter em mente que quaisquer atualizações no IDE provavelmente substituirão suas alterações no boards.txt, então como podemos evitar esse problema? 

2.3.1.4.1 Placas.local.txt 

Desde a versão 1.6.6 do Arduino IDE, um novo arquivo foi introduzido, boards.local.txt 

, no qual você pode definir vários parâmetros que deseja usar em vez daqueles no arquivo boards.txt. Para continuar o exemplo anterior de alteração do bootloader, você poderia criar o arquivo, se ele não existir, e adicionar o seguinte a ele: uno.bootloader.file=meu_novo_bootloader/meu_novo_bootloader_atmega328.hex Isso pressupõe que você não precisará de nenhum espaço Flash RAM adicional para o bootloader além do exigido pelo bootloader atual. Se você fizer isso, adicione o seguinte também: 

uno.upload.maximum_size=<o que for necessário> 

 2.3.1.5 Configurações de compilação 

uno.build.mcu=atmega328p 

uno.build.f_cpu=16000000L 

uno.build.board=AVR_UNO 

uno.build.core=arduino 

uno.build.variant=padrão 

A configuração build.mcu define o nome do microcontrolador para esta placa específica. Para o Uno, apenas um ATmega328P está definido. Para outras placas, a Nano, por exemplo, existem dois microcontroladores diferentes disponíveis, o ATmega168 e o ATmega328P. Dentro de cada uma dessas duas placas, existem duas configurações diferentes, e o boards.txt possui entradas para cada variante com configurações globais para todos os Nanos, bem como as configurações específicas para as diferentes placas microcontroladoras e suas variantes. 

O parâmetro build.f_cpu define o relógio do sistema (CLKcpu) da placa. O Uno possui um cristal de 16 MHz instalado, então essa é a velocidade definida neste exemplo. Esta 



configuração é usada em seus esboços, embora você não a veja, pois a variável F_CPU é usada, por exemplo, ao calcular a taxa de transmissão desejada ao usar a interface serial. 

A propriedade build.board é usada para definir uma variável de tempo de compilação ARDUINO_{build.board} para permitir o uso de código condicional entre #ifdefs em esboços e/ou arquivos de cabeçalho. O Arduino IDE gera automaticamente um valor build.board se não for definido. Neste exemplo, a variável definida em tempo de compilação será ARDUINO_AVR_UNO. 

Para determinar qual caminho de arquivo deve ser usado quando o compilador estiver procurando por vários arquivos, main.cpp, por exemplo, a configuração build.core é usada. O parâmetro é usado para construir um caminho para os arquivos em $ARDINST/cores/<uno.build.core>/, que, para o Uno neste exemplo, será $ARDINST/cores/arduino/. 

A variante da placa é então definida usando a configuração build.variant. Isto é usado para construir um caminho para os arquivos que residem em 

$ARDINST/variants/<uno.build.variant>/ e é onde você encontrará o arquivo chamado pins_arduino.h que define quaisquer variações sobre as configurações padrão que se aplicam a este placa específica. Para este exemplo de Uno, o caminho definido será $ARDINST/variants/standard/. 

O IDE define diversas configurações globais para os vários caminhos para os núcleos e variantes. Eles estão disponíveis em outros arquivos de configuração, mas não possuem o prefixo da placa, então uno.build.core corresponderia à configuração global do IDE de build.core. Caso a placa não especifique uma configuração, será utilizada a global; entretanto, quando uma placa tiver uma configuração apropriada, ela substituirá a global criada pelo IDE, quando a placa apropriada for selecionada no menu Placas no IDE. 

Você pode ver algumas dessas configurações globais no arquivo platform.txt. 

 2.3.1.6 Configurando um ICSP 

Se você sempre quiser usar um ICSP (In-Circuit System Programmer) para programar uma placa específica, você pode adicionar a seguinte linha ao arquivo 

$ARDINST/boards.txt ou $ARDINST/boards.local.txt, provavelmente como parte de as configurações de compilação conforme detalhado anteriormente, por exemplo: uno.upload.using=USBtinyISP 

O nome que você usa aqui é um dos que podem ser encontrados no arquivo 

$ARDINST/programmers.txt, que é descrito posteriormente neste capítulo, na Seção 2.5, “Programmers.txt”. 

Você deve fazer essa alteração enquanto o IDE estiver fechado. Na próxima vez que você abrir o IDE, sempre que selecionar o dispositivo Uno como sua placa, ele selecionará automaticamente o dispositivo USB Tiny ISP, neste caso, para realizar os uploads, ao invés do bootloader. 

Se desejar fazer essa alteração como padrão para todos os quadros, você deverá editar o arquivo preferências.txt, conforme documentado na Seção 2.1, “Preferências.txt”, anteriormente neste capítulo. 


2.4 Plataforma.txt 

O arquivo $ARDINST/platform.txt define recursos específicos da plataforma e ferramentas de linha de comando, onde as bibliotecas residem e como são chamadas, e assim por diante. Ele contém as diversas receitas utilizadas pelo IDE para compilar, construir, fazer upload e/ou programar diversos dispositivos e placas de acordo com suas diferentes necessidades. 

O que é uma plataforma? Pois bem, no caso do ATmega328P, ou outros 

microcontroladores AVR, a plataforma define todas as ferramentas, compiladores, linkers, linhas de comando a serem utilizadas e assim por diante, para os microcontroladores Atmel AVR. Outras placas microcontroladoras não AVR terão sua própria plataforma para definir as ferramentas específicas e outras para aquele microcontrolador específico. Placas Arduino com, por exemplo, um chip ARM usarão uma plataforma diferente daquelas com microcontroladores AVR. 

Usar este método permite uma maneira bastante simples de atualizar o sistema para lidar com novas placas. 

O sistema Arduino requer que este arquivo defina os seguintes metadados: nome=<nome da plataforma> 

versão=<versão da plataforma> 

O nome será mostrado no menu Tools ➤ Boards do Arduino IDE, em texto 

acinzentado, acima da lista de placas que estão em conformidade com esta plataforma específica. De acordo com a documentação no site do Arduino 

emhttps://github.com/arduino/Arduino/wiki/Arduino-IDE-1.5-3rd-party-Hardware-

specification,  a versão não está em uso no momento e está reservada para uso futuro. 

Para o Arduino IDE versão 1.8.5, vemos isto no topo do arquivo: 

nome = Placas Arduino AVR 

versão=1.6.22 

Obviamente, o número da versão da plataforma pode e é diferente da versão do IDE. 

Não fique confuso se você ver algo diferente. 

2.4.1 Construir Receitas 

O arquivo platform.txt, conforme mencionado anteriormente, contém uma grande quantidade de metadados que configuram o IDE para ser capaz de compilar esboços e carregá-los, entre outras coisas, para as placas Arduino rodando com 

microcontroladores AVR. Isso é feito por meio de receitas. Ter receitas diferentes para todas as plataformas permite que o IDE seja usado em uma infinidade de dispositivos diferentes. 

Quando você seleciona uma compilação no IDE, um pequeno número de configurações é criado automaticamente para você. São os seguintes: 

• 

build.path – O caminho para a pasta temporária para armazenar vários 

arquivos criados pelo processo de construção. 

• 

build.project_name – O nome do projeto (esboço). 

• 

build.arch – A arquitetura do microcontrolador, que no nosso caso é “avr” mas, dependendo da placa, pode ser “sam”, “arm” e assim por diante. O IDE obtém isso dos caminhos para $ARDINST. 



No meu sistema, $ARDINST é definido como 

$ARDBASE/hardware/arduino/avr – e as partes do caminho definem o local da pasta de hardware, $ARDBASE/hardware; depois o nome do fornecedor, 

arduino; e por fim a arquitetura, avr para placas com o ATmega328P. Para placas Arduino SAM, o caminho seria $ARDBASE/hardware/arduino/sam. A 

parte final do caminho fornece o nome build.arch. 

Várias configurações adicionais são definidas no arquivo $ARDINST\boards.txt com base na placa específica escolhida no menu Ferramentas ➤ Placas – consulte a Seção 2.3, “Boards.txt”, para obter esses detalhes – e as variáveis globais do IDE podem ser usado neste arquivo também. Você pode encontrar mais detalhes sobre essas variáveis na Seção 2.2, “Caminhos definidos globalmente”. 

O processo de compilação pode ler arquivos de origem escritos em C simples – são os arquivos de origem .c, C++ (.cpp) ou até mesmo linguagem assembly (.S). Ele precisa saber como converter esses arquivos em arquivos objeto (.o) que podem ser reunidos pelo vinculador para criar um arquivo executável. A maneira como isso acontece é usando as receitas do arquivo platform.txt. 

As receitas são variáveis no formato 

receita.<formato_fonte>.o.pattern 

E o “source_format” é simplesmente a extensão dos arquivos em questão. Isso nos dá as seguintes variáveis: 

• 

Recipe.copattern – Para converter arquivos C em arquivos objeto 

• 

Recipe.cpp.o.pattern – Para converter arquivos C++ em arquivos objeto 

• 

Recipe.Sopattern – Para converter arquivos de linguagem assembly em 

arquivos de objeto 

Você notará, espero, que o formato de origem em cada um diferencia maiúsculas de minúsculas. Os arquivos em linguagem assembly devem ter uma extensão .S 

maiúscula. 

Tomando um deles como exemplo, foi isso que encontrei em meu arquivo platform.txt para o Arduino IDE versão 1.8.5: 

## Compilar arquivos c 

receita.copattern="{compiler.path}{compiler.c.cmd}" {compiler.c.flags} 

-mmcu={build.mcu} -DF_CPU={build.f_cpu} -DARDUINO={runtime.ide.versão} 

-DARDUINO_{build.board} -DARDUINO_ARCH_{build.arch} {compiler.c.extra_flags} 

{build.extra_flags} {inclui} "{source_file}" -o "{object_file}" 

Se dividirmos a receita anterior em suas partes constituintes, veremos as seguintes variáveis e opções de linha de comando: 

• 

"{compiler.path}{compiler.c.cmd}" define onde a ferramenta do compilador pode ser encontrada – {compiler.path} – e como ela é chamada, 

{compiler.c.cmd}. O uso de aspas duplas permite espaços e outros caracteres não alfanuméricos no caminho ou nome do comando. 



No IDE, vejo que {compiler.path} está definido como {runtime.tools.avr-

gcc.path}/bin/; e como você pode ver, essas receitas podem referir-se a outras variáveis definidas neste arquivo ou em outro lugar. O {compiler.c.cmd} é definido como avr-gcc, e este não é realmente o compilador, mas um front end para todas as fases do processo de compilação e que pode ser usado para controlar todo o processo. 

• 

{compiler.c.flags} define uma lista de sinalizadores e opções a serem passadas para o utilitário {compiler.c.cmd} para definir como a construção deve 

progredir, quais saídas são necessárias e assim por diante. Existem inúmeras opções no IDE 1.8.5; mas um em particular, -c, diz ao front end do compilador para parar de compilar após a criação do arquivo objeto e não executar a fase de link. 

• 

-mmcu={build.mcu} define outra opção do compilador. Ele informa ao 

compilador C qual microcontrolador está em uso na placa. Ele vem de 

$ARDINST/boards.txt e, para o Uno, é definido como 

uno.build.mcu=atmega328p. A parte do nome, uno, é removida primeiro. 

• 

-DF_CPU={build.f_cpu} é muito útil ao escrever código para múltiplas placas. A velocidade do clock do microcontrolador AVR é definida no processo de 

compilação, em vez de ser codificada nos arquivos de origem reais, por 

exemplo, #define F_CPU 16000000L. Isso exigiria edição antes de ser executado em uma placa com uma velocidade de clock diferente. 



A variável é definida em $ARDINST/boards.txt e, para o Uno, é 

uno.build.f_cpu=16000000L. A parte do nome, “uno.”, é removida primeiro. 

• 

-DARDUINO={runtime.ide.version} define um valor numérico para a versão do Arduino IDE em uso. Ele é criado automaticamente pelo IDE e é descrito na Seção 2.2, “Caminhos definidos globalmente”. Para o IDE versão 1.8.5, por exemplo, torna-se 10805. 

• 

-DARDUINO_{build.board} faz referência à variável uno.build.board=AVR_UNO 

do $ARDINST/boards.txt – o exemplo mostrado é, mais uma vez, para o Uno. 

Isso pode ser usado em código condicional para determinar a placa em uso e, a partir disso, se determinados recursos estão disponíveis ou não. Neste 

exemplo, definiria uma variável chamada ARDUINO_AVR_UNO. 

• 

-DARDUINO_ARCH_{build.arch}, conforme descrito anteriormente, define a 

arquitetura para a qual estamos construindo. Para os propósitos deste livro, será “avr” dando ARDUINO_ARCH_avr. 

• 

{compiler.c.extra_flags} são alguns sinalizadores adicionais que você ou eu podemos definir em $ARDINST/platform.local.txt para serem adicionados à linha de comando desta receita. Por padrão, estes estão em branco. 

• 

{build.extra_flags} são alguns sinalizadores adicionais que você ou eu podemos definir em $ARDINST/boards.local.txt para serem adicionados à linha de 

comando desta receita. Por padrão, estes estão em branco. 

• 

{includes} é a lista de caminhos que o compilador usará para procurar arquivos 

#incluídos nos vários arquivos de origem. O formato é -I/include/path e assim por diante. Você pode ter mais de um caminho. A documentação on-line tem o seguinte a dizer: 



 Observe que as versões mais antigas do IDE usavam o receita.preproc.includes receita para determinar inclui, que não está documentada aqui. Desde o 

Arduino IDE 1.6.7 (arduino-builder 1.2.0) isso foi alterado e 

Recipe.preproc.includes não é mais usado. 



Isso não é realmente muito útil, pois inclui permanece não documentado, e mesmo a receita “não mais usada” Recipe.preproc.includes na verdade tem 

{includes} como parte de sua definição. 

• 

"{source_file}" é o caminho para o arquivo de origem único que está sendo compilado. As aspas duplas permitem espaços e outros caracteres não 

alfanuméricos no nome do arquivo. 

• 

-o "{object_file}" é o caminho para o arquivo de objeto único que será criado na fase de compilação. As aspas duplas permitem espaços e outros caracteres não alfanuméricos no nome do arquivo. 

2.4.2 Ganchos pré e pós-construção 

Ganchos pré e pós-construção foram introduzidos no Arduino versão 1.6.5 e são encontrados no arquivo $ARDINST/platform.txt. Na versão 1.8.5, os seguintes ganchos estão disponíveis para seu uso: 

• 

Recipe.hooks.sketch.prebuild.NUMBER.pattern – Chamado antes da 

compilação do esboço 

• 

Recipe.hooks.sketch.postbuild.NUMBER.pattern – Chamado após a compilação do esboço 

• 

Recipe.hooks.libraries.prebuild.NUMBER.pattern – Chamado antes da 

compilação das bibliotecas 

• 

Recipe.hooks.libraries.postbuild.NUMBER.pattern – Chamado após a 

compilação das bibliotecas 

• 

Recipe.hooks.core.prebuild.NUMBER.pattern – Chamado antes da compilação principal 

• 

Recipe.hooks.core.postbuild.NUMBER.pattern – Chamado após a compilação 

principal 

• 

Recipe.hooks.linking.prelink.NUMBER.pattern – Chamado antes da vinculação 

• 

Recipe.hooks.linking.postlink.NUMBER.pattern – Chamado após a vinculação 

• 

Recipe.hooks.objcopy.preobjcopy.NUMBER.pattern – Chamado antes da 

execução da receita objcopy 

• 

Recipe.hooks.objcopy.postobjcopy.NUMBER.pattern – Chamado após a 

execução da receita objcopy 

• 

Recipe.hooks.savehex.presavehex.NUMBER.pattern – Chamado antes da 

execução da receita savehex 

• 

Recipe.hooks.savehex.postsavehex.NUMBER.pattern – Chamado após a 

execução da receita savehex 

Eles são identificados pela parte Recipe.hooks. A próxima parte determina em qual estágio da compilação o gancho será chamado. Prexxxxx e postxxxxx indicam que o padrão será chamado antes ou depois do estágio apropriado. 

Para que vários ganchos possam ser chamados em qualquer estágio, a parte NUMBER 

é um número de sequência que deve ser 1, 2, 3, 4 e assim por diante – há um número 





para cada gancho executar em um determinado estágio do processo. O final da receita é sempre a palavra padrão. 

Se você achar que precisa de dez ou mais ganchos, então suas NÚMERAS peças deverão ser 01, 02, .. , 10, 11 e assim por diante. 

Após o sinal de igual estão os comandos que você deseja executar. Por exemplo, em $ARDINST/platform.local.txt, você pode adicionar o seguinte no Linux: 

Recipe.hooks.sketch.prebuild.1.pattern=echo Compilando esboço: {build.source.path} 

receita.hooks.sketch.postbuild.1.pattern=echo Compilado 

Ou o seguinte no Windows: 

Recipe.hooks.sketch.prebuild.1.pattern=cmd /C echo Compilando esboço: 

{construir.fonte.caminho} 

receita.hooks.sketch.postbuild.1.pattern=cmd /C echo Compilado" 

Percebi que algumas variáveis, mas não todas, não são expandidas. Usar 

"{source_file}", por exemplo, não expande, mas {build.source.path} sim. Além disso, todo o texto após o sinal de igual torna-se parte da mensagem, não apenas a saída do comando. O código anterior, no Linux, exibe o texto “echo Compiling sketch: 

/full/path/to/my/sketch/here” em vez de apenas “Compiling sketch: 

/completo/caminho/para/meu/esboço/aqui”. Algo semelhante acontece com o Windows. 

O comando usado não pode ser um comando integrado e deve ser 

encontrado no caminho do seu sistema ($PATH no Linux e MacOS, %path% no Windows). 

No Windows, o comando echo é um comando integrado. Ele não pode ser encontrado em %path% quando a compilação é iniciada, então toda a compilação falha porque echo não pode ser encontrado. Isso ocorre devido à maneira como o comando Java exec, de Runtime.getRuntime(), funciona. 

Então, como o comando echo anterior funcionou no Windows? Criei um arquivo echo.bat e coloquei-o no meu Windows% PATH%. 

Os comandos a serem executados nos ganchos devem ser encontrados no $PATH; caso contrário, eles não serão executados e a receita falhará. 




2.5 Programadores.txt 

O arquivo programmers.txt é o menos documentado dos vários arquivos de texto usados pelo Arduino IDE. As páginas do Wiki descrevem os outros arquivos, mas nada além de uma breve menção ao seu nome, para programmers.txt. 

Presume-se, possivelmente incorretamente, que as pessoas que criam e constroem novos dispositivos ICSP sabem o que todos os parâmetros significam e fornecerão uma lista de entradas necessárias para que seus dispositivos sejam adicionados ao programmers.txt. 

Também é provável que sempre que alguém criar ou atualizar um dispositivo de programação ou configurações, ele será enviado aos mantenedores do Arduino para inclusão na próxima versão do software. 

O arquivo programmers.txt será substituído a cada nova atualização do IDE, portanto, se você fez alguma alteração, você realmente deve manter um registro delas antes de atualizar. 

$ARDINST/programmers.txt contém detalhes sobre os vários dispositivos de programação que o Arduino IDE pode usar para fazer upload de código para sua placa Arduino. Ao contrário de boards.txt e platform.txt, o IDE não parece reconhecer uma variante local, programmers.local.txt, mesmo que exista. Portanto, quaisquer alterações feitas em sua própria instalação precisarão ser feitas no arquivo $ARDINST/programmers.txt fornecido e isso será substituído quando o IDE for atualizado. 

Como isso é um pouco incômodo, registrei o problema 8556 sobre isso 

emhttps://github.com/arduino/Arduino/issues/8556.  Pode ser que isso seja intencional e não um problema real. Veremos o que acontece. 

O arquivo contém parâmetros que são relevantes para os diversos dispositivos de programação que podem ser usados e, dependendo das configurações, eles podem aparecer nas diversas opções de menu no menu Ferramentas do IDE. 

Um exemplo de entrada no arquivo é o seguinte: 

usbtinyisp.name=USBtinyISP 

usbtinyisp.protocol=usbtiny 

usbtinyisp.program.tool=avrdude 

usbtinyisp.program.extra_params= 

Isto é para o ICSP (In-Circuit System Programmer) “USB Tiny” e mostra o seguinte: 



• 

O nome do dispositivo, conforme aparecerá no menu Ferramentas ➤ 

Programador. Neste caso, é “USBtinyISP”. Você pode alterar isso se preferir usar um nome diferente. 

• 

O protocolo a ser usado ao executar a opção IDE para “Upload usando 

programador”. 

• 

A ferramenta que será usada durante o upload. Aqui podemos ver que ele é definido como o uso do utilitário avrdude. 

• 

Quaisquer parâmetros extras que possam ser necessários para fazer o upload. 

Neste exemplo, não há nenhum. No entanto, se algum for necessário, deverá ser consistente com a sintaxe da ferramenta de programação em uso. 

Se, por exemplo, o dispositivo exigir que uma porta serial seja usada para o upload, você poderá adicionar o seguinte: 

usbtinyisp.program.extra_params=-P{serial.port} 

Isso permitiria que a linha de comando passada para avrdude fosse fornecida com a opção -P, para selecionar uma porta serial, e seria definida com o valor escolhido no IDE na opção de menu Ferramentas ➤ Porta. 

Obviamente, este é apenas um exemplo; o dispositivo USB Tiny não precisa de uma porta serial. 


2.6 Compilando um esboço 

Ao abrir um projeto no Arduino IDE, você notará que todos os arquivos no diretório do projeto com extensão .ino, .h, .c ou .cpp são colocados em uma guia própria. 

Presume-se que estes sejam todos os arquivos de origem que compõem o seu projeto. 

Você pode, se desejar, abrir outros arquivos dentro do IDE, mas eles não serão abertos automaticamente em guias separadas quando você reabrir o projeto posteriormente. 

Eles terão que ser abertos manualmente se for necessária edição ou visualização. 

Você também deve estar ciente de que não existe uma função chamada main() em nenhum dos arquivos abertos no projeto. Qualquer pessoa que tenha programado em C ou C++ saberá que main() é o ponto de entrada do programa. O que está acontecendo? 

O Arduino IDE fornece sua própria função main(), para que você não precise fazer isso. Para facilitar a vida dos fabricantes e desenvolvedores de microcontroladores iniciantes, o sistema Arduino esconde muitas coisas de você. Darei uma olhada na função main() em breve. 

Quando você compila um projeto no Arduino IDE, uma série de coisas acontecem, e esses processos separados são descritos no restante deste capítulo. Seu esboço será convertido em um arquivo C++ pelo pré-processador Arduino. 

2.6.1 Pré-processamento do Arduino Sketch (*.ino) 

Um esboço do Arduino é um arquivo fonte C++ muito simplificado que pode ser composto de muitos arquivos com a extensão .ino e, ocasionalmente, alguns arquivos adicionais com a extensão .cpp. Para converter o esboço em um arquivo C++ válido, uma série de ações são realizadas: 

• 

 Talvez crie uma pasta de trabalho temporária do compilador na pasta ou diretório temporário principal do sistema. Isso estará dentro de /tmp no Linux e algo parecido com 

c:\users\<your_name>\AppData\Local\Temp\arduino_build_<some_number> 

\ no Windows. Isso acontece apenas na primeira compilação deste esboço 

específico. Para o restante desta discussão, me referirei a esta pasta como $TMP. 

• 

Se o seu esboço for composto por vários arquivos .ino, esses arquivos serão concatenados em um único arquivo .ino.cpp, na subpasta $TMP/sketch, 

começando com o arquivo de esboço principal que é o arquivo .ino com o 

mesmo nome como o nome da pasta do esboço. O restante dos arquivos .ino são anexados ao final do arquivo principal, em ordem alfabética. Se o seu esboço fosse denominado Blink.ino, o arquivo gerado seria denominado 

$TMP/sketch/Blink.ino.cpp. 

• 

A linha #include <Arduino.h> é adicionada no início do arquivo .ino.cpp, se ainda não estiver presente. 

• 

Todas as bibliotecas usadas no esboço são detectadas e os caminhos de 

inclusão dessas bibliotecas são descobertos. Isso é feito executando uma compilação fictícia com a saída sendo descartada (para o dispositivo nulo no Windows e /dev/null no Linux) e processando quaisquer mensagens de erro relevantes. 

• 

São gerados protótipos para todas as funções no arquivo .ino.cpp. Se, como acontece ocasionalmente, um protótipo de função válido não puder ser gerado automaticamente, você precisará adicionar um explicitamente ao arquivo .ino que define a função com falha. 

• 

O arquivo .ino.cpp é processado para que haja diretivas relevantes do pré-processador do compilador #line e #file para que o relatório de erros seja preciso e faça referência às linhas corretas nos arquivos de origem corretos, em vez de fazer referência às linhas dentro do arquivo .ino.cpp concatenado. 

arquivo ino.cpp. 



Essas ações são executadas pela ferramenta de pré-processador arduino que fica no GitHub emhttps://github.com/arduino/arduino-preprocessor.  

2.6.2 Construção do Arduino Sketch (*.ino) 

Após o pré-processamento, a construção é concluída pela ferramenta arduino-builder, encontrada emhttps://github.com/arduino/arduino-builder,  qual 

• 

Compila o arquivo .ino.cpp, criado pelo estágio de pré-processamento, em um módulo com extensão .ino.cpp.o. Este arquivo de módulo é armazenado na 

subpasta $TMP/sketch criada pela ferramenta Arduino Preprocessor descrita anteriormente. 

• 

Compila todos os outros arquivos .c ou .cpp, incluindo main.cpp, em módulos separados na subpasta $TMP/sketch. 


Se a configuração do sketch – a placa e assim por diante – não mudou 

desde a compilação anterior, então alguns destes módulos podem ser 

reutilizados em vez de recompilados. Isso economiza tempo na segunda e nas compilações subsequentes. Isso só é feito se o(s) arquivo(s) de origem do módulo a ser reutilizado não tiver(em) sido editado(s) ou alterado(s), é claro. 

• 

Quaisquer bibliotecas usadas pelo esboço também serão compiladas como 

módulos separados. Mais uma vez, eles serão gravados como arquivos .o na subpasta $TMP/libraries. 

• 

Os arquivos principais do Arduino são compilados como arquivos .o em 

$TMP/core. Esses arquivos principais são como wireing_analog.c, 

wireing_digital.c e assim por diante, conforme instalados no IDE. 

• 

Os módulos principais individuais (*.o) são então integrados em uma única biblioteca estática, core.a, na subpasta $TMP/core – por exemplo, no Windows, c:\users\<seu_nome>\AppData\Local\Temp 

\arduino_build_<algum_número>\core\core.a. 

• 

Depois que todos os módulos foram criados, o vinculador combina todos eles em um único arquivo binário no formato elf. Este arquivo fica na pasta 

temporária principal criada anteriormente e será nomeado 

$TMP/<sketch_name>.ino.elf, $TMP/Blink.ino.elf, por exemplo. 

• 

O arquivo $TMP/<sketch_name>.ino.elf é então usado para criar um arquivo chamado $TMP/<sketch_name>.ino.eep que contém dados a serem gravados na área EEPROM do microcontrolador AVR. 

• 

O arquivo $TMP/<sketch_name>.ino.elf também é usado para criar um arquivo chamado $TMP/<sketch_name>.ino.hex que contém o código usado para 



atualizar o microcontrolador AVR com seu esboço. Este código está no formato 

“Intel Hex”. 

Isso encerra o processo de compilação. Se o botão de upload for clicado no IDE, em vez do botão de compilação (ou verificação), o arquivo $TMP/<sketch_name>.ino.hex será carregado no microcontrolador AVR, usando uma versão específica do Arduino da ferramenta avrdude que pode ser encontrado no GitHub 

emhttps://github.com/arduino/avrdude-build-script.  

Há uma opção de menu, Sketch ➤ Export Compiled Binary, que exportará os arquivos hexadecimais compilados para a pasta do sketch. Isso pode ser usado para passar cópias do seu aplicativo para seus amigos fazerem upload, sem permitir que eles vejam seu código-fonte. Existem dois arquivos criados: 

• 

Sketch_name.ino.standard.hex – Este é o arquivo hexadecimal para carregar seu código e apenas seu código. 

• 

Sketch_name.ino.with_bootloader.standard.hex – Este arquivo, se carregado, escreverá o bootloader e o código do seu aplicativo. 

Se você tiver um bootloader instalado em seu ATmega328P, poderá usá-lo para fazer upload dos arquivos usando o avrdude. Normalmente, ao usar um ICSP para programar seu dispositivo, o bootloader será sobrescrito quando o chip for apagado. 

No entanto, se você usar o ICSP para fazer upload do arquivo anterior com o bootloader, você efetivamente gravará um bootloader, bem como o código do seu aplicativo, na placa Arduino. 

Qualquer arquivo pode ser carregado usando o bootloader – se ainda estiver
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